
Fonts in Mac OS X
Using fonts with Adobe applications in Mac OS X

Mac OS X treats fonts differently than earlier Macintosh operating systems. It 

supports a broader variety of font formats natively, which offers you greater flexibility and may let you output 

your customers’ files more reliably. But as with any operating system, it’s important to understand how fonts 

are organized, how applications read those fonts, and where the pitfalls lie. Working with fonts can be chal-

lenging if you’re running both native Mac OS X applications and Classic applications—or if you’re working 

in a cross-platform shop. Additionally, font managers work a little differently in Mac OS X than they did in 

earlier operating systems. 

F O N T  F O R M AT S

Mac OS X rasterizes several font formats 

without requiring a separate utility such as 

Adobe Type Manager® (ATM). When fonts 

are placed in one of the system’s standard font 

locations, Mac OS X handles the following 

formats natively: OpenType, Macintosh 

PostScript Type 1, Multiple Master, TrueType 

(Macintosh or Windows), and TrueType 

dFont. You can use these fonts in any native 

Mac OS X application. 

OpenType (*.otf or *ttf)

Mac OS X natively supports OpenType fonts, 

which offer three main advantages: all font 

information is stored in a single file; the same 

font works equally well on Macintosh and 

Windows platforms; and one OpenType font 

can contain many more characters than other 

fonts, including specialized glyphs. 

Mac OS X applications display OpenType 

fonts in their menus. All of the characters and 

typographic features in an OpenType font 

are available in applications that understand 

In this issue, we discuss the font formats and 

font locations supported in Mac OS X, as well 

as the font managers available. We show you 

how to remove conflicting system fonts when 

necessary, and offer troubleshooting tips for 

the issues you are most likely to encounter 

working with fonts and Adobe applications 

in Mac OS X. For more information about 

working with Mac OS X and Adobe applica-

tions, read “Using and Managing Fonts in 

Mac OS X,” available from Apple’s Web site 

at http://www.apple.com/creative/fonts, and 

“A Service Provider’s Guide to Mac OS X,” 

which will be available soon on Adobe’s Web 

site at http://partners.adobe.com/asn/service/

indesign/main.html. 
Continued on page 2
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Unicode, such as Adobe InDesign® 2.0.2 and Adobe Photoshop® 7.0.1. 

However, in applications that don’t understand Unicode, such as Adobe 

Illustrator® 10.0.3, only the standard character set is available. 

Mac OS X supports OpenType fonts natively only in native Mac OS X 

applications. To use OpenType fonts in Classic applications, you must 

install Adobe Type Manager (ATM) Light or Deluxe 4.6 or later in the 

Classic environment. ATM Light is available as a free download from Ado-

be’s Web site at http://www.adobe.com/products/atmlight/main.html.

In Mac OS X 10.2.5 and earlier, large OpenType fonts might cause 

a print job to fail; Mac OS X 10.2.6 resolves this issue. In general, 

however, OpenType fonts present no special challenges for printing 

or for creating Adobe PDF files. Once OpenType fonts are part of the 

PostScript print stream or are in a PDF file, they appear no different 

to PostScript RIPS than Type 1 or TrueType fonts. The exception is in 

PDF files exported from InDesign, which encodes the fonts as Type 1 

CID fonts (see “Support for OpenType in InDesign” below). Acrobat 

Distiller® may also encode fonts as CID fonts. Some RIPs aren’t able 

to process CID fonts correctly.

Adobe OpenType fonts

OpenType fonts from Adobe have either “Std” (for Standard) or “Pro” 

in the font menu names and the PostScript FontName, to prevent con-

flicts with legacy Type 1 fonts and Mac OS X system dFonts. (System 

dFonts frequently do conflict with legacy Type 1 fonts, however.) The 

actual glyphs vary from font to font, but those with “Std” in their name 

have character sets similar to their Type 1 counterparts, plus some addi-

tional symbol and currency characters. Standard OpenType fonts may 

also include glyphs that were formerly in separate “expert set” fonts. 

Fonts with “Pro” in their names include Central European language 

support, and may have Greek or Cyrillic support. Pro fonts generally 

include additional typographic features, such as ligatures or true small 

caps, too. To see which glyphs are included in any font in the Adobe 

Type Library, refer to the font browser at http://www.adobe.com/type.

Adobe recently finished converting its entire font library to OpenType 

format, and is planning to release a new version of Adobe Font Folio™  

that contains OpenType versions of the full Adobe Type Library. Adobe 

expects to offer an upgrade path for current registered Font Folio users.

Support for OpenType in InDesign 

InDesign 2.0.2 includes extensive support for OpenType fonts. You 

can access OpenType font features in the Glyphs palette and using 

commands from the Character palette menu, and you can include 

OpenType features in character and paragraph styles. Five OpenType 

font families are included in the Goodies folder on the InDesign instal-

lation CD. For information on using OpenType fonts in InDesign 

2.0.2, see the OpenType User Guide, included in the Goodies folder on 

the InDesign CD—or download it from http://www.adobe.com/type/

browser/pdfs/OTGuide.pdf.

Continued from page 1

Continued on page 3

When you export an Adobe PDF document from InDesign, Open-

Type fonts are encoded as Type 1 CID fonts (CID stands for Character 

IDentifier, a number used to identify characters in many Asian fonts). 

Similarly, InDesign includes TrueType fonts as CID-encoded TrueType 

fonts and PostScript Type 1 fonts as CID-encoded Type 1 fonts when 

exporting to PDF. Many older RIPs developed by vendors other than 

Adobe that claim compatibility with PostScript Level 2 (and sometimes 

even PostScript 3™) may have problems processing CID-encoded fonts 

correctly. However, many of the RIP vendors have since made patches 

or updates available. If you directly export InDesign documents to 

PDF in your workflow, make sure your RIP can correctly process 

CID-encoded fonts. 

Support for OpenType in Photoshop

Photoshop 7.0.1 provides more limited support for OpenType fonts 

than InDesign. It doesn’t include a Glyphs palette, but you can use its 

Character palette to apply features like small caps or old style numbers 

which are in an OpenType font.

TrueType dFonts (*.dfont)

The system fonts that come with Mac OS X are TrueType fonts, installed 

in several locations (see page 3). Some of these fonts, which are stored 

in special packaging that will work on a Unix File System (UFS), are 

called dFonts (data fork fonts). Unlike the TrueType fonts in earlier 

Mac OS versions, dFonts contain all of the font information; there is 
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no additional resource fork. While these are high quality fonts, they are 

not recommended for workflows where users might want to open the 

document on a Mac OS system earlier than Mac OS X, as neither ATM 

nor Mac OS 9 and earlier recognize TrueType dFonts. If a customer 

provides you with a file created in Mac OS X using dFonts, output the 

file from a Mac OS X system where the fonts are installed and activated. 

PostScript Type 1 fonts may have different font metrics, so if you try 

to substitute them for the dFonts, text may reflow.

Mac OS X comes with the following dFonts installed in the /System/

Library/Fonts folder: Apple LiGothic Medium, AppleGothic, Courier, 

Geneva, Hei, Helvetica, Keyboard, LastResort, LucidaGrande, Monaco, 

Osaka, OsakaMono, Symbol, Times, and ZapfDingbats. Additionally, 

these fonts are installed in the /Library/Fonts folder: #Gungseouche, 

#HeadlineA, #Pcmyoungjo, #Pilgiche, AmericanTypewriter, Apple 

LiSung Light, AppleMyungjo, Baskerville, Beijing, BiauKai, BigCaslon, 

CharcoalCY, Cochin, Copperplate, Didot, Fang Song, Futura, GenevaCY, 

GillSans, HelveticaCY, HelveticaNeue, Herculanum, Kai, MarkerFelt, 

MonacoCY, Optima, Papyrus, Seoul, Song, Taipei, TimesCY, Zapfino.

The names of several system dFonts (such as Helvetica, GillSans, and 

ZapfDingbats) conflict with existing PostScript or TrueType fonts so 

you may want to remove those dFonts. However, the fonts that are 

stored in the System/Library/Fonts folder, which is a locked system 

location, require special treatment. (See “Removing conflicting dFont 

system fonts” on page 4.)

Other font formats

In general, PostScript Type 1 (Macintosh), Multiple Master, and True-

Type fonts work as they did in earlier versions of Mac OS. However, 

there are a few ways they behave differently: 

• Type 1 fonts may conflict with system TrueType dFonts that have 

the same name.

• You can use Multiple Master fonts and the instances you have 

already created, but you can’t create new instances in Mac OS X.

• Mac OS X supports both Windows and Macintosh TrueType fonts. 

To use Windows TrueType fonts, place them in one of the standard 

font locations, or activate them in Suitcase or Font Reserve.

F O N T  LO C AT I O N S  I N  M A C  O S  X

Mac OS X is designed to be a multi-user operating system, so fonts 

are organized in a way that provides a font folder for each user 

(/Users/<username>/Library/Fonts), a folder for shared resources 

(/Library/Fonts), a folder for fonts used by the operating system 

(/System/Library/Fonts), and if you’re running a Mac OS X Server, 

a folder for shared network fonts (/Network/Library/Fonts). Addi-

tionally, fonts in the Classic System Folder (/System Folder/Fonts) 

are read by the operating system whether Classic is running or not, 

provided the Classic environment has been run once or the Classic 

System Folder has been selected at least once in the Startup Disk pane 

of System Preferences.  

Classic applications, such as QuarkXPress, can only use fonts in the 

Fonts folder inside the Classic System Folder. Mac OS X applications 

can use  fonts in all the locations listed above. 

In most cases, when a Mac OS X application asks the operating system 

to find a font, the system looks in the locations in the order listed in 

the chart on this page, and the first match it finds is the one it uses. 

However, Adobe applications use their own core font technology to 

build font menus, and they don’t follow this order. In fact, if more 

than one font with the same name is installed on your system, dif-

ferent versions of the font may be listed in the menus of InDesign, 

Illustrator, and Photoshop. 

Font locations for Adobe applications

Adobe applications look for fonts in their own font folders, in addi-

tion to the standard Mac OS X font locations. InDesign 2.0.2 has its 

Continued from page 2

Continued on page 4

 

Font Locations in Mac OS X

Application’s Fonts folder Adobe applications have separate 

font folders, inside the application 

folder or in the Application Support 

folder.

/Users/<username>/Library/

Fonts

Place your fonts here if you’re on a 

single-user system, you’re not using a 

font manager, and you don’t need the 

fonts in Classic applications.

/Library/Fonts Only a user with an administrator 

login can add or delete fonts from 

this folder. If you’re in a multiuser 

environment, and you’re not  using 

a font manager, place your fonts here 

to be a shared resource for all users.

/Network/Library/Fonts This folder is a network location 

on a Mac OS X server running 

NetInfo, where a “universal” set of 

fonts could be located. This location 

won’t appear if you’re not running a 

Mac OS X server.  

/System/Library/Fonts All fonts used by the Mac OS X 

system are placed here, including 

many dFonts. Don’t put any of your 

fonts here.
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own Fonts folder in the InDesign application folder. InDesign always 

reads fonts placed there. 

Illustrator 10.0.3, Photoshop 7.0.1, InDesign 2.0.2, and Adobe Acro-

bat 5.0.5 also read fonts located in the /Library/Application/Support/

Adobe/fonts folder.

Sometimes you can use these folders as a way of working around 

problems. For example, at the time of this article, Mac OS X may not 

recognize all installed instances of a multiple master font that is placed 

in one of the standard OS-level font folders. If you place the instances 

in the /Library/Application/Support/Adobe/ fonts folder, you can be 

sure they will be available to Adobe applications. 

F O N T  M A N A G E R S  I N  M A C  O S  X

Most print service providers rely on a font manager to let you activate 

only those fonts you need for a particular job, eliminating the pos-

sibility of font conflicts, and shortening font menus. The way you use 

font managers has changed for Mac OS X. For example, the Mac OS 

X system handles font rasterization itself, rendering that function of 

ATM unnecessary. Therefore, Adobe isn’t developing ATM Deluxe for 

Mac OS X. If you’ve been using ATM Deluxe, you’ll need to switch to 

a font manager that supports Mac OS X. 

Currently, only two font managers support Mac OS X: Extensis Suitcase 

and DiamondSoft Font Reserve. However, two new font management 

applications for Mac OS X were announced in January 2003: a Mac 

OS X update of Alsoft MasterJuggler (http://www.alsoft.com), and 

FontAgent Pro from Insider Software (http://www.insidersoftware.com/

products/fontagentpro).

Both Extensis Suitcase 10.1.3 (http://www.extensis.com/suitcase) and 

DiamondSoft Font Reserve 3.1.1 (http://www.fontreserve.com) have 

been rewritten for Mac OS X. They each manage fonts in both Mac 

OS X and Classic applications (except OpenType fonts, which are sup-

ported in Mac OS X only). Additionally, they both have plug-ins that 

allow font autoactivation in InDesign 2.0.2, and Illustrator 8, 9, and 

10.0.3. (With autoactivation, the font manager automatically activates 

a font used by a document when that document is opened, if that font 

is not already active.) Both applications also have font server products 

that are compatible with Mac OS X.

Extensis Suitcase comes with a copy of Font Doctor, a font diagnosis 

and repair utility, and a utility to convert ATM Deluxe font sets into 

Suitcase sets. Suitcase uses separate databases for Mac OS and Classic, 

so you have to manage fonts separately for each environment. One 

limitation of Suitcase is that it doesn’t give you the ability to move or 

disable conflicting system dFonts. If you want to do that, you’ll have to 

use the manual method we describe here. (See “Removing conflicting 

dFont system fonts” on this page.)

DiamondSoft Font Reserve has a Classic Activator which works differ-

ently than Suitcase’s database. It is an invisible Classic application that 

launches whenever Classic launches. It automatically enables in Classic 

any fonts that were enabled by Font Reserve in Mac OS X (except for 

OpenType fonts and other fonts which aren’t supported by the Classic 

environment). FontReserve also allows you to move the dFonts not 

actually used by the system to the Font Reserve Vault so you can turn 

them on and off. 

R E M O V I N G  CO N F L I C T I N G  D F O N T  S YS T E M  F O N T S

Because Mac OS X system dFonts may conflict with Type 1 fonts your 

customers use, you may need to move some dFonts that are preinstalled 

in Mac OS X folders. If you don’t move them, you can’t use your font 

manager to activate and deactivate them.

Font Reserve includes a System Font Handler that removes system fonts 

automatically, but you can also remove the fonts manually. 

Note: Some applications and preference panels in Mac OS X require 

that Helvetica or Helvetica Neue be active. If you remove system fonts, 

be sure to activate these fonts in your font manager or place them in 

your user folder. It doesn’t matter which version you activate: Type 1, 

TrueType, or OpenType. 

Using the Font Reserve System Font Handler

The first time you launch the Font Reserve browser, you’ll receive 

a warning that the system fonts need to be checked. Choose File 

> System Font Handler, and then click Check All on each of the 

fonts panels to select all the nonessential fonts. Font Reserve doesn’t 

permit you to select system fonts that the system requires to run. 

The Font Handler moves the fonts to the Font Reserve Vault and 

adds them to its database. You can then use Font Reserve to activate 

and deactivate these fonts. For more information about the Font 

Reserve System Font Handler, refer to the Font Reserve Quick Start 

Guide for Mac OS X. 

Removing the fonts manually

If you’re not using Font Reserve, you can remove the system fonts 

manually: 

1. First, quit any Classic applications and move Courier, Helvetica, 

Times, Symbol, and ZapfDingbats from the System Folder/Fonts 

folder to a new folder (such as one named “Fonts Removed”). Do 

not remove Charcoal, Geneva, and Monaco, which are required 

by many Classic applications.

2. Move all the fonts from the /Library/Fonts folder into a new folder 

(such as one named “Fonts_Unused”). 

3. Move all the fonts from the /Users/<username>/Library/Fonts 

folder into the new “Fonts_Unused” folder as well. 

Continued from page 3

Continued on page 5
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4. If you’re using Type 1 versions of Courier, Helvetica, Symbol, Times, 

and Zapf Dingbats, move the dFont versions of these fonts from the 

/System/Library/Fonts folder to a “Fonts_Removed” folder. These 

system fonts are locked; therefore, to move those fonts, you must 

change the permissions for the /System/Library/Fonts: Select the 

folder and choose File > Get Info. In the Ownership and Permis-

sions section, click the lock icon to unlock the files. Enter your 

Administrator password in the Authentication dialog box. Choose 

your name followed by “(Me)” from the Owner pop-up menu.  

Note: Serious problems might result if you remove fonts other than the 

ones named. Some of the fonts are required for system use, and this 

could conceivably damage your system to the point where you would 

have to reinstall Mac OS X. Apple is constantly updating Mac OS X and 

its bundled applications, so it’s good practice to test with your current 

system to see if any fonts are still required.

T R O U B L E S H O OT I N G  F O N T  I S S U E S

Font issues in Mac OS X can be more complex and harder to diagnose 

than in Mac OS 9 and earlier Macintosh operating systems because 

fonts may be located in a variety of folders. Following are some 

common symptoms and possible solutions for font issues you may 

encounter.

Font styles missing in InDesign menu

InDesign generates its own font menus. If it encounters font name 

conflicts, InDesign 2.0.2 uses the following rules to handle them. (The 

rules differ for earlier versions of InDesign.)

• If the font family name is “Courier” or “Helvetica,” InDesign shows 

the font that includes more styles. Usually, this is the PostScript 

Type 1 font.

• If one of the fonts is bitmap, InDesign uses the non-bitmap font.

• If neither of the first two rules apply, InDesign uses the font with the 

most glyphs (this may be a dFont, instead of a PostScript font).

• If the fonts contain the same number of glyphs, the font will be 

chosen in this order: (1) PostScript Type 1, (2) TrueType, (3) CID, 

(4) AdobeTypeComposerFont, (5) Bitmap.

If a style doesn’t appear in the menus, it may be because both a dFont 

and a PostScript Type 1 or TrueType font share the same name. Remove 

the conflicting dFont to resolve the problem.

Duplicate font names in Illustrator or Photoshop

If two fonts have the same name,  Illustrator and Photoshop list them 

both. To resolve this problem, remove the duplicate font—usually either 

a dFont font from the system’s Fonts folder or a font installed in the 

Classic Fonts folder. However, if you’re running Classic applications, 

such as QuarkXPress, keep the version of the font in the Classic Fonts 

folder and remove any others. Otherwise, your Classic applications 

and Mac OS X applications (such as Illustrator 10.0.3) may not use 

the same version of the font.

An application won’t launch or quits unexpectedly

There are many reasons an application may quit unexpectedly, but 

some of the reasons can be font-related.

• An Apple application such as Mail, Address Book, TextEdit, iCal, 

or some third-party applications may not launch or may quit 

unexpectedly if Helvetica or Helvetica Neue isn’t activated. If you 

removed or disabled these fonts to remove conflicts, be sure to 

install or activate any version of the fonts.

• Sometimes applications quit unexpectedly if a font is corrupted. 

Use a font utility such as Font Doctor X or FontAgent Pro to 

detect and sometimes repair corruption. If you don’t have such 

a utility, open only minimal fonts and slowly add other fonts to 

the system to isolate a corrupted font. Then delete and reinstall 

that font.

• Adobe’s core font technology creates cache files which can some-

times get corrupted. Search for AdobeFnt files on your system 

drive, and delete the files that have a .lst extension. (Adobe appli-

cations re-create these files as needed.)

Not all multiple master instances appear in the font menu

In Mac OS X 10.2, multiple master fonts are rasterized by the operating 

system. There have been reports that not all instances of the multiple 

master fonts appear in some font menus. To ensure your Adobe appli-

cations find multiple master font instances, install them in the Adobe 

application font folders.

Swatch libraries are missing from Illustrator

A damaged font or AdobeFnt file can cause swatch libraries to be miss-

ing from Illustrator. For help resolving this issue, see the Adobe support 

document, “Swatch libraries are missing from Illustrator 10.x in Mac 

OS X” at http://www.adobe.com/support/techdocs/2c1ba.htm.

R E S O U R C E S

“Using and Managing Fonts in Mac OS X” 

http://www.apple.com/creative/fonts

“A Service Provider’s Guide to Mac OS X” (available soon)

http://partners.adobe.com/asn/service/indesign/main.html

OpenType User Guide

http://www.adobe.com/type/browser/pdfs/OTGuide.pdf

Other OpenType resources

http://www.adobe.com/type/opentype/

Continued from page 4
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Information about each of these issues is available in Adobe’s online 

technical support database. The links will take you directly to the 

“living documents”—information that is kept current by Adobe 

Technical Support staff. Issues that are platform-specific are pre-

ceded by MAC or WIN. You can read about issues that have the Adobe 

logo  next to them by clicking the URL. To search for informa-

tion about other issues in the technical support database, visit http:

//www.adobe.com/support/database.html. To find issues that appear 

in ReadMe Now, type RMN or ReadMe Now along with other search 

criteria (e.g., InDesign) into the search field. For tips on searching the 

database, visit http://www.adobe.com/support/queryhelp.html.

Acrobat® Solutions

Error “... unsafe attachment ...” or “... file corrupt...” when opening PDF 
attachments in Outlook Express 6

http://www.adobe.com/knowledgebase/328154

Issue 

When you try to open a PDF file that was sent as an attachment in 

Microsoft Outlook Express, one of the following errors occur:

— “Outlook Express removed access to the following unsafe 

attachment(s) in your email: [file name]”

— “Cannot open because the file is corrupt” 

Detail

You installed one of the following service packs: Internet Explorer 

6 Service Pack 1, Windows XP Service Pack 1, or Outlook Express 6 

Service Pack 1.

Solution 

If you’re sure that the PDF file doesn’t contain a virus, disable virus 

protection in Outlook Express, and then open the PDF file:

1. If the error message is still open in Outlook Express, close it. 

2. Choose Tools > Options, and then click the Security tab.

3. Deselect Do Not Allow Attachments To Be Saved Or Opened That 

Could Potentially Be a Virus, and then click OK.

4. Double-click the PDF attachment to open it.

Note: After you view the file, reenable virus protection. 

Additional Information 

Service packs for Internet Explorer 6 and Windows XP install Outlook 

Express 6 Service Pack 1, which enables virus protection by default. 

When virus protection is enabled, Outlook Express doesn’t allow you 

to open most e-mail attachments, especially those that have file types 

considered unsafe by Internet Explorer or Windows. For example, 

Internet Explorer considers the EXE file type unsafe because many 

viruses are distributed as EXE files.

InDesign® Solutions

Preflight Feature Doesn’t Detect RGB Color in Images InDesign 2.x for 
Windows or Mac OS

http://www.adobe.com/knowledgebase/320945

Issue 

Images in an InDesign document don’t separate or proof as expected , 

even though the Preflight Summary states, “0 use RGB color space.” 

Detail

The images are EPS files, Macromedia Freehand files, Adobe Illustrator 

files, or InDesign objects. 

Solution 

Determine which images use the RGB color space, and change their 

color space to CMYK.

To determine which images use the RGB color space:

— For linked images, open each image in its original application to 

determine if it uses the RGB color space. 

— For InDesign objects, select an object, and note the highlighted 

color swatch in the Swatches palette: The RGB color space is indi-

cated by an icon with vertical stripes. (When the selection tool is 

positioned over the icon, the tool tip displays RGB values.)

Additional Information 

The InDesign user guide indicates that the Preflight utility lists any 

RGB images, including those that are linked or embedded. However, the 

utility is unable to detect RGB color in the following types of images: 

InDesign objects, EPS files with embedded RGB images, Illustrator 

files,  and Freehand files.

Technical Solutions
technical news and known issues for ASN service providers

Continued on page 7
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MAC: Adobe InDesign 2.0.2 Memory update - all languages 

http://www.adobe.com/support/downloads/detail.jsp?ftpID=2115

When using InDesign 2.0.x in Mac OS X on a computer that has more 

than 1.5GB of installed RAM, one or more of the following problems 

may occur: 

— “Not enough memory” error is displayed when activating a clip-

ping path from the Object menu. 

— “Out of memory” error is displayed when selecting an EPS or TIFF 

file and trying to create a clipping path. 

— Applying text wrap to an object using a contour option fails to 

respond. 

The InDesign 2.0.2 Memory update resolves these issues. To verify 

how much RAM is installed on your computer, select About This Mac 

from the Apple menu. 

MAC: Binary Printing Option Isn’t Available in InDesign 2.x on Mac OS 
X v10.2.x

http://www.adobe.com/knowledgebase/328346

Mac OS X v10.2.x doesn’t support binary printing, so you cannot 

choose the Binary option from the Data Format pop-up menu in 

InDesign. As an alternative, you can try either of these workarounds: 

Disclaimer: Adobe doesn’t support these workarounds.

— Print to a printer that can be connected directly to your computer 

via USB, and use a printer driver that supports binary data. To 

determine if a printer driver supports binary data, contact the 

manufacturer of the printer driver or see its documentation.

— Print to a PostScript file using the PostScript File option in the 

Printer pop-up menu in the Print dialog box, and then print the 

PostScript file by using a RIP or third-party software. You’ll need 

printer queues or hot folders for use as output devices. Printer 

queues or hot folders are provided through a RIP or third-party 

software. 

Adobe InDesign 2.0.2 Long Document Performance update - all languages 

http://www.adobe.com/support/downloads/main.html

When text is reflowed in a document in InDesign, (for example, by 

adding text to a story or placing a frame with text wrap over a story), 

the text may be slow to recompose if the story contains a large amount 

of text. The Long Document Performance update resolves this issue.

Errors “...cannot load the TEXT WRAP.RPLN plug-in...”and “...Text Wrap 
plug-in failed to register” When You Start InDesign 2.0-2.1 

http://www.adobe.com/knowledgebase/320951

Issue 

When you try to start InDesign, it returns the following errors:

— “Adobe InDesign cannot load the TEXT WRAP.RPLN plug-in. The 

TEXT WRAP.RPLN plug-in requires the 2.2 version of InDesign. 

Please contact the vendor to get a compatible version of TEXT 

WRAP.RPLN”

— “Cannot load Adobe InDesign because it requires the Text Wrap 

plug-in. The Text Wrap plug-in failed to register.”

Detail

You installed the Adobe InDesign 2.0.2 Long Document Performance 

update.

Solution 

Remove and reinstall InDesign, update to InDesign 2.0.2, and then 

reinstall the Adobe InDesign 2.0.2 Long Document Performance 

update: 

Note: You can download the updates from Adobe’s Web site at http:

//www.adobe.com/support/downloads/main.html.

Windows 

1. Exit from all applications.

2. Move any personal files from the Adobe InDesign 2.0 folder to 

another folder. (Personal files include documents, updates, user 

dictionary files, and third-party plug-ins.)

3. Choose Start > Settings > Control Panel, double-click Add or 

Remove Programs, select Adobe InDesign [version], and then click 

Remove (Windows XP) or Add/Remove (Windows 2000, NT, Me, 

98). Follow the on-screen instructions.

4. Restart Windows.

5. Reinstall InDesign from the InDesign 2.0 CD-ROM.

6. If the CD installs InDesign 2.0 rather than 2.0.1, install the 

InDesign 2.0.1 update. 

7. Install the InDesign 2.0.2 update.

8. Install the Adobe InDesign 2.0.2 Long Document Performance 

update. 

Mac OS

1. Quit all applications.

2. If you use Mac OS X, log in as administrator. 

3. At the Finder, move any personal files from the Adobe InDesign 

2.0 folder to another folder. (Personal files include documents, 

updates, user dictionary files, and third-party plug-ins.)

4. Drag the Adobe InDesign 2.0 folder to the Trash, and then empty 

the Trash.

5. Reinstall InDesign from the InDesign 2.0 CD-ROM.

6. If the CD installs InDesign 2.0 rather than 2.0.1, install the 

InDesign 2.0.1 update.
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7. Install the InDesign 2.0.2 update.

8. Install the Adobe InDesign 2.0.2 Long Document Performance 

update. 

Additional Information 

The Adobe InDesign 2.0.2 Long Document Performance update 

requires InDesign 2.0.2. If you install the update into an earlier ver-

sion of InDesign, InDesign returns errors and doesn’t start.

The InDesign 2.0.2 update requires InDesign 2.0.1.

Installation Instructions Are Missing for the Adobe InDesign 2.0.2 Long 
Document Performance Update (Windows and Mac OS)

http://www.adobe.com/knowledgebase/321320

Installation instructions are not included for the Adobe InDesign 

2.0.2 Long Document Performance update when you download 

it from www.versiontracker.com. You can find the instructions 

on Adobe’s Web site at http://www.adobe.com/support/downloads/

detail.jsp?ftpID=2101 (Windows) or http://www.adobe.com/support/

downloads/detail.jsp?ftpID=2100  (Mac OS).

Photoshop® Solutions

MAC: Problems With Photoshop Keyboard Shortcuts in OS X version 
10.2 (Jaguar)

http://www.adobe.com/knowledgebase/325589

Issue 

Keyboard shortcuts for Photoshop 7.x either don’t work or stop work-

ing in Mac OS X v10.2.

Solution 1

Update to Mac OS X v10.2.5 or later. You can download the update from 

Apple’s Web site at http://www.info.apple.com/support/downloads.html.

Solution 2

When the keyboard shortcuts stop working, restart Mac OS.

Solution 3

In the case of the Command+~ shortcut, install the Mac OS X Keyboard 

Shortcut Fix for Photoshop 7.x. You can download the shortcut fix 

from Adobe’s Web site at http://www.adobe.com/support/downloads/

product.jsp?product=39&platform=Macintosh.

Additional Information 

Mac OS X v10.2 is incompatible with keyboard shortcuts for numerous 

applications, including Photoshop. Apple is aware of the problem and 

is working to resolve it. Adobe recommends that you install system 

updates as Apple provides them.

In Mac OS X version 10.2, the Command+~ keyboard shortcut is 

reserved for cycling through an application’s open document windows. 

This change in OS X conflicts with Photoshop, which uses this shortcut 

to select the image composite in the Channels palette or the master 

channel in the Levels and Curves dialog boxes.

To cycle through open document windows in Photoshop, use the 

keyboard shortcut Control+Tab. 

Installer for Camera Raw Plug-in Quits or Returns Error

http://www.adobe.com/knowledgebase/328641

Issue 

When you try to install the Camera Raw plug-in for Photoshop 7.x 
or Adobe Photoshop Elements 2.x, the installer either quits (Mac OS) 

or returns the error “Error creating registry set” followed by “Thank 

you for choosing Photoshop Camera Raw & JPEG2000” (Windows).

Solution 1

Make sure that the application folder for Photoshop or Photoshop Ele-

ments has its default name, and then install the Camera Raw plug-in. 

The default folder names are as follows:

— (Windows) Photoshop 7.0 and Photoshop Elements 2

— (Mac OS) Adobe Photoshop 7 and Adobe Photoshop Elements 2

Solution 2

Make sure that the PNG file format plug-in (Png.8bi) is in the correct 

folder, and then install the Camera Raw plug-in. The correct folder for 

the PNG file format plug-in is as follows:

Photoshop:

— Windows: Photoshop 7/Plug-ins/Adobe Photoshop Only/File 

Formats

— Mac OS X: Applications/Adobe Photoshop 7/Plug-ins/Adobe 

Photoshop Only/File Formats

— Mac OS 9.x: Adobe Photoshop 7: Plug-ins: Adobe Photoshop 

Only: File Formats

Photoshop Elements:

— Windows: Photoshop Elements 2/Plug-ins/File Formats

— Mac OS X: Applications/Adobe Photoshop Elements 2/Plug-ins/

File Formats

— Mac OS 9.x: Adobe Photoshop Elements 2: Plug-ins: File Formats

Additional Information

The Camera Raw plug-in installer searches for the Photoshop or the 

Photoshop Elements folder and the PNG file format plug-in. If the 

installer can’t find these items, it quits or returns an error. 

 WIN: Using Adobe Gamma in Windows 

http://www.adobe.com/knowledgebase/321608

Continued from page 7
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There are so many plug-ins, educational products, and other resources 

available for working with Adobe applications that it can be challeng-

ing to find those appropriate to streamline your particular workflow. 

To assist you, each month we feature resources we think you’ll find 

useful.

Adobe sells third-party plug-ins on its Web site at 

http://www.adobe.com/products/plugins/main.html.

Adobe provides many training resources on its Web site at 

http://www.adobe.com/misc/training.html.

Adobe Type

Font Reserve 3.1.1 and Font Reserve Server 

DiamondSoft

http://www.diamondsoft.com

Font Reserve uses a proprietary SQL database to help you manage 

your fonts, and to distinguish one version of a font from another. It 

supports PostScript, TrueType, Windows TrueType, Multiple Master, 

Apple dFont, OpenType, and double-byte fonts. 

With Font Reserve, you can do the following: 

• Search for and sort fonts based on eleven categories of informa-

tion, possible because of the database architecture. Information 

in the database includes the font’s name, file name and location, 

kind, class, foundry, version number, kerning pairs, outline file 

size, and more. 

• Add, organize, and view fonts using the Font Reserve Browser, 

which provides an intuitive, customizable interface to display as 

much or as little information as you want. 

• Automatically move all nonessential fonts from the System Fonts 

folders into your Font Reserve Vault or onto your desktop using 

the System Font Handler. Once the fonts are moved, you can acti-

vate and deactivate them using Font Reserve, so you can prevent 

conflicts with other fonts. 

• Activate copies of fonts to prevent corruption. 

• Easily activate fonts permanently or temporarily. 

• Activate the correct font automatically when you open documents 

in most applications in Mac OS 9 and Mac OS X. 

• See all the characters in a font at once, at any size you like, using 

the Character Map. 

• Ensure that your fonts are safe and usable. Font Reserve checks 

fonts for corruption and makes repairs as it adds them to the 

database. 

• Choose to store all your fonts in the Font Reserve Vault, or store 

them in traditional font folders. 

Font Reserve Server

In addition to Font Reserve Single User, DiamondSoft offers Font 

Reserve Server, which provides workgroups with real-time access to 

the same fonts, user permissions to control font access, the ability to 

track font licenses, and automated backups, along with the features of 

Font Reserve Single User. 

Display fonts individually, in suitcases, or by typecase 
family in the Font Reserve Browser. 
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